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Introduction

About this document

The purpose of this document is to guide you step by step in exploring the various basic features
of Scilab for a user who has never used numerical computation software. This presentation is
voluntarily limited to the essential to allow easier handling of Scilab.

Computations, graphs and illustrations are made with Scilab 2025.0.0. You can reproduce all those
commands from this version.

Install Scilab

Scilab is numerical computation software that anybody can freely download. Available under
Windows, Linux and MacOS, Scilab can be downloaded at the following address:
http://www.scilab.org/

You can be notified of new releases of Scilab software by subscribing to our channel notification at
the following address: http://lists.scilab.org/mailman/listinfo/release

Mailing list

To facilitate the exchange between Scilab users, dedicated mailing lists exist (list in French, list for
the education world, international list in English). The principle is simple: registrants can
communicate with each other by e-mail (questions, answers, sharing of documents, feedbacks...).

To browse the available lists and to subscribe, go to the following address:
https://www.scilab.org/about/community/mailing-lists.

Additional resources

We invite you to visit Scilab website where you will find tutorials for the use of Scilab at the
following address: https://www.scilab.org/tutorials.

You can also find a lot of material on the Indian website of Scilab: https://scilab.in/. In particular:

e Spoken tutorials:
https://spoken-tutorial.org/tutorial-search/?search foss=Scilab&search language=English

e Textbook Companion Project where examples from standard scientific textbooks have
been made in Scilab. More than 600 textbooks have already been made:
https://scilab.in/Completed Books
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Chapter 1 — Become familiar with Scilab

The useful workspace in Scilab consists of several windows:

e The console for making calculations,

e The editor for writing programs,

e The graphics windows for displaying graphics,
e The embedded help.

The general environment and the console

After double-clicking the icon to launch Scilab, Scilab environment by default consists of the
following docked windows — console, files and variables browsers, command history (see
“Windows management and workspace customization”, page 10):

B scilab 2025.00 Console
File Edit Control Applications ?
ZEXE0% S2 8 X T

File Browser 2 2% Variable Browser 2 ax

[ |crprogram Fiestsalab-2025.0.01 v & Name value Tyoe Visbility Memory

Name ] fens | 1x1] Boolean| local| 2128
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[B5 2cib-2025.0.0 Londing iniviel envirommens
4.

BEgbin
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et
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tools Command History 2z ax
ACKNOWLEDGEVENTS T2/01/2025 1186 6

[ CHANGES.md
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[ copving 8D

[ scilabwebsite.url
[] unins000.dat
[ uninso00.exe
[T version.ind

Hews feed 2
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Sciab is open source,
Giing back support o use cases s apprediated.

- Add and improve fnctons on Gitlzb.
- View and edit help pages.

. toolboxes on ATOMS,
« Post questions on Discourse.

M QY

In the console after the prompt “ -=> “, just type a command and press the Enter key (Windows
and Linux) or Return key (MacOS) on the keyboard to obtain the corresponding result.

--> 57/4
ans =
14.25
—=> (2+9) 75 Mention
Before the result, ans is
ans = - “ ”
displayed for “answer”.
161051.

It is possible to come back at any moment with the keyboard's arrow keys & P = { or with the
mouse. The left and right keys are used to change the instructions and the up and down keys are
used to come back on a previously executed command.
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Simple numerical calculations

All computations done with Scilab are numerical. Scilab performs computations with matrices (see
chapter 2, page 22).

Operations are written with “ + “ for addition, “ = “ for subtraction, “ * “ for multiplication, “ / “
for division, “ ~ “ for exponents. For example:

-->2+3.4

The case is sensitive. It is thus necessary to respect uppercase and lowercase for the calculations
to be performed properly. For example, with sqrt command (which calculates the square root):

—-->sqrt (9) while: -->SQRT (9)

ans = Undefined variable: SQRT

Particular numbers
%e and $pi represent respectively € and 7:

—-—=> S%e -——> %pi

oo

e = gpi =

2.7182818 3.1415927

%1 represents the i of complexes in input and is displayed i in output:

-=> 2+3*%1i

For not displaying the results

In adding a semi colon “ ; “ at the end of a command line, the calculation is done but the result is
not displayed.

——>(1+sqrt (5))/2; -—> (l+sqgrt(5))/2
ans =

1.618034
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To remind the name of a function

The names of commonly used functions are summarized in Chapter 3 of this document (page 31).
For example:

Mention

All available functions are
also listed in the embedded
help by clicking in the menu
0.0060699 bar on ? > Scilab Help.

--> exp(10)/factorial (10)

ans =

The tab key > | on the keyboard can be used to complete the name of a function or a variable by
giving its first few letters.

For example, after typing in the console the command:
-->fact

and then pressing the tab key, a window is displayed with all the functions and variables names
beginning with fact, such as factorial and factor. Just double click on the required
function or select it with the mouse or with the keys 1 {, and press Enter (Windows and Linux) or
Return (MacOS) to insert it in the command line.

The menu bar
The menus listed below are particularly useful.
Applications

e The command history allows you to find all the commands from previous sessions to the
current session.

e The variables browser allows you to find all variables previously used during the current
session.

Edit

Preferences (in Scilab menu under MacOS) allows you to set and customize colors, fonts and font
size in the console and in the editor, which is very useful for screen projection.

Clicking on Clear Console clears the entire content of the console. In this case, the command
history is still available and calculations made during the session remain in memory. Commands
that have been erased are still available through the keyboard’s arrow keys.

Control
To interrupt a running program, you can:

e Type pause in the program or click on Control> Interrupt in the menu bar (Ctrl X under
Windows and Linux or Command X under MacQS), if the program is already running. In all
cases, the prompt “ ==>“ will turn into “ -1->“, then into “ -2-> “..., if the operation
is repeated.

e To return to the time prior to the program interruption, type resume in the console or
click on Control > Resume.

e To quit for good a calculation without any possibility of return, type abort in the console
or click on Control > Abort in the menu bar.
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The editor

Typing directly into the console has two disadvantages: it is not possible to save the commands
and it is not easy to edit multiple lines of instruction. The editor is the appropriate tool to run
multiple instructions.

Opening the editor

|

To open the editor from the console, click on the first icon in the toolbar == or on Applications >
SciNotes in the menu bar.

The editor opens with a default file named “Untitled 1 “.

Writing in the editor
Typing in the editor is like as in any word processor.

In the text editor, opening and closing parentheses, end loops, function and test commands are
added automatically. However, these features can be disabled in Options > Auto-completion on
menu, in clicking on the two below entries enabled by default:

e (L

e if,function,...

While in principle each instruction should be entered on a separate line, it is possible to type
multiple statements on a same line separating each statement with a semicolon “ ; “.

A space at the start of the line called indentation is automatic when a loop or a test is started.
In the following example, we calculate 10 terms of the sequence (u,,) defined by:

{ul =1
Unp1 = 2Up — 3

r 5% Untitled 1 - SciNotes — [m] b4

File Edit Format Options Window Execute 7

==L =R T=] 50 &FR|>D &

| =Untitied 1 3¢

u(l)=

for-n=
u{nt+l)=2*a(n)-
disp([n,u(n)])

sncll

R

Mention

- Comments preceded with “ // “ will not be taken into account in the calculations.

- To change the font, click on Options > Preferences.

- When writing a program, indentation is automatic. If this is not the case, click on Edit > Correct indentation to restore it (Ctrl |
under Windows and Linux or Command | under MacOS).
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Saving
Any file can be saved by clicking on File > Save as.

The extension “ .sce “ at the end of a file name will launch automatically Scilab when opening it
(except under Linux and MacQS).

Copying into the console, executing a program
In clicking on Execute in the menu bar, three options are available:

e Execute “..file with no echo “ (Ctrl Shift E under Windows and Linux, Cmd Shift E under
MacOS): the file is executed without writing the program in the console (saving the file
first is mandatory).

e Execute “... file with echo “ (Ctrl L under Windows and Linux, Cmd L under MacOS):
rewrite the file into the console and executes it.

e Execute “...until the caret, with echo “ (Ctrl E under Windows and Linux, Cmd E under
MacOS): rewrite the selection chosen with the mouse into the console and executes it or
execute the file data until the caret position defined by the user.

Standard copy/paste can also be used.

The graphics window
Opening a graphics window

A graphics window opens automatically when making any plot. It is possible to plot curves,
surfaces, sequences of points (see chapter 2, page 17).

To obtain an example of curve, type in the console:

-->plot
| B Graphic window number 0 = a X
| File Tools Edit 7
Mention
B BOQTYH O .
: - To erase a previous plot,
Graphic window number 0 2
type clf
“ : "
i — — e (“ clear figure “). .
£ o - “o . - To open another graphics
s 47 o (f“ a, window,.type scf; (“set
o q -1 o current figure “).
o o o o . .
| 0l o o If several graphic windows
B o are open, you can choose in
[ +] e} . .
05 ] o o which the plot will be drawn
% & by typing sc£ (n); n for the
aQ o . .
4 : : : : : , : : Q-oI 9-0 : : : graphics window number
0 05 1 15 2 25 3 35 4 45 5 55 6 G5 T (mentioned on the top left).
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Modifying a plot

The magnifying glass @% allows zooming. To zoom in two dimensions, click on the tool and with
the mouse create a rectangle which will constitute the new enlarged view. To zoom in three
dimensions, click on the tool and create a parallelepiped which will constitute the new enlarged
view. It is also possible to zoom by using the mouse wheel. To return to the initial screen, click on

the other magnifying glass .

The icon % enables rotation of the figure (particularly useful in 3-D) with right click actions which
are guided by messages in the bottom of the graphics window.

For more precise modifications, click on Edit > Figure properties or Axes properties and let

yourselves be guided (this option is not yet available under MacOS).

Online help

To access the online help, click on ? > Scilab Help in the menu bar, or type in the console:

B Help Browser o x W
File Tools Language Online lssues ?
P55 @
B a
Matrix -shaping <<sech Trigonometry sind ==
Matrix operations
Search and sort
Set operations Scilab Help >> Elementary Functions > Trigonometry = sin
Trigonometry
Matrix-wse processing .
® acos sin
» acosd
* acosh
# acot sine function
* acod
* acoth Syntax
® acsc
® acscd [t] = sin(x)
® acsth
- @ asec Arguments
» asecd
» asech x
® asn a real or complex vector or matri.
# csnd
# asinh P
® atan Description
® atand
® atarh
® cos For a vector ora matrix, =in (x) is the sine of its elements. For matrix sine use sinm(x) function.
* cosd s
ample
- @ cosh P
® cord
* cog
* ot
» o |
* o
* o os
® sec
® secd
® sech os
£y
- @ sind 04
@ s
® tn 0z

Mention

Examples of use can be
executed in Scilab and
edited in SciNotes in using
the associated buttons in
the example framework.

To get help with any function, type doc (formerly help) in the console followed by the name of

the appropriate function. For example:
-->doc sin

displays help for sin (sine) function.
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Windows management and workspace customization

As in the default Scilab environment, where the console, files and variables browsers and
command history are all together docked windows, all other windows in Scilab can be repositioned
in a single one. For example, the user can choose to position the editor in the default environment

of Scilab.

To dock a window in another one, first identify the blue horizontal bar under Windows, or black
under MacOS and Linux, at the top of the window in the toolbar containing a question mark on the

right.

e Under Windows and Linux, click on this bar with the left mouse button and, while
maintaining the click, move the mouse pointer in the desired window.
e Under MacQOS, click on this bar and while maintaining the click, move it in the desired

window.

A rectangle appears indicating the future positioning of the window. When the position is the one
you want, release the mouse button. To cancel and bring out the window, click on the small arrow

on the right of the same bar.

Fde Edit Contral Applications 7

FE|A GO Y &2 ST
Pl Browasr T 7 X Scba0zs00 Conson
B9 |cProgram Fiesipeiob-2025.0.01 *

= [lexl doubls]

n 0T

Z Untitled 1 - SciNiotes - o x
File Edit Fornal Options Window Erecute Trpe

FEIERIE AG0@EE>T RIK ®

TCCIEREAC]
G wigow mesbar 0

|
- * ot ")
&
for n=i12
()=
-
plats, ™)
news tees rax

- Discover Sckab commurity

" Sciels s open source,
o
B g back spprt or e cases b appreciated

B & ® ADDREE P R|X O

ERf Ay .
B [rmm e man .

e i w

[ 22500
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- N

Commsed wistory ax

Hors=)
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Chapter 2 - Programming

In the examples given in this document, any line preceded by “ ==>“ is a command, the other
lines are the returns from commands (calculation results, error messages...). Do not write “ ==>“
in the editor. They are introduced here to make the distinction between command lines and
calculation results as it is displayed in the console after copying/pasting. When presented in a table
(without “ ==> “ and no calculation result), the commands are depicted exactly as they should be
typed in the editor.

Variables, assignment and display
Variables

Scilab is not a computer algebra system. It calculates only with numbers. All calculations are done
with matrices, although this may go unnoticed. Even if the concept of matrices is unknown, vectors
and sequences of numbers are used, as they are, in fact, matrices with dimension 1 xnornx 1
and a number is itself a matrix with dimension 1 x 1.

Variables do not need to be declared in advance, but any variable must have a value. For example,
obtaining the value of a variable which has not been given a value produces an error:

-->a
!——error 4

Undefined variable : a

If a value is assigned to the variable a, there is no longer an error:
--> a=%pi/4
a =

0.7853982

0.7853982

Variables may take any name that is not already defined by the system:

--> Piby2=%pi/2

. Mention
Piby2 = Like the Scilab functions, a
1.5707963 variable name must not
have accents or special
characters.
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The result of a calculation that is not assigned to a variable is automatically assigned to the
variable called ans:
-=>3*(4-2)

ans =

—-—>ans

ans =

Functions

Functions are the easiest and most natural way to make computations from variables and for
obtaining results from variables.

A function definition begins with function and ends with endfunction. For example, to
convert euros (e) in dollars (d) with an exchange rate (t), the dollars function is defined. The
variables are e and t and the image is d.

-->function d=dollars(e,t); d=e*t; endfunction

-->dollars (200,1.04)
ans =

208.

Very usually numerical functions are functions of one real variable. For example, two functions £

and g are defined using the following commands:

Mention

The variables x and y are
dummy variables, their
names can be reused when

-->function y=g(x); y=4*x/9+4; endfunction defining other functions or
in Scilab.

-->function y=f (x); y=36/(8+exp(-x)); endfunction

The defined functions can then be used to calculate values:
--> f£(10)
ans =
4.4999745
-=> g(12.5)
ans =

9.5555556
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Requesting the assignment of a variable

Assignment is made easily using the “ = “ operator.

Display
Writing

Typing the name of a variable displays its value, except when there is “ ; “ at the end of the

command line.

Brackets

Matrices are defined using square brackets (see page 22). As mentioned before, matrix
computation is the basis of calculations in Scilab. A space or comma is used to separate columns

and semicolons are used to separate rows.

To define a column vector and obtain a column display:

-=>v=[3;-2;5]
v = [3x1 double]
3.
- 2.
5.

To define a row vector and obtain a row display:
-—>v=[3 -2 5]
v = [1x3 double]

3. - 2. 5.

To define a matrix and obtain a tabular display:

-->m=[1 2 3;4 5 6;7 8 9]

m = [3x3 double]
1. 2. 3.
4 5. 6
7 8. 9

Mention

This command can also be
typed under the form:
v=[3,-2,5]

Mention

This command can also be
typed under the form:
m=[1,2,3;4,5,6;7,8,9]
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disp function
disp must always be used with parentheses.
With the vector v previously defined:

-->v (2)

ans =

To display a string (usually a sentence), put it between quotes:
-->disp ("Bob won")

Bob won

To display a combination of words and values use the string command which converts values
to character strings using a “ + “ between the different parts:

-->d=500;

-->disp ("Bob won "+string(d)+" dollars")

Bob won 500 dollars

If the sentence contains an single quote, the latter needs to be doubled in the string to be
displayed properly:
-->disp ("It''s fair")

It's fair

Loops
Incrementation

The “ : “ operator allows to define vectors of numbers whose coordinates are in arithmetic
sequence. We give: << beginning value: step: ending value>>. It is possible that “ending value” is
not reached. If the step is not mentioned, its default value is 1.

For example, to define a row vector of integers which increments in steps of 1 from 3 and 10:
-->3:10
ans = [1x8 double]
3. 4. 5. 6. 7. 8. 9. 10.
or which increments in steps of 2 from 1 to 10:
-->1:2:10
ans = [1x5 double]

1. 3. 5. 7. 9.
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or which decreases in steps of 4 from 20 to 2:

-—>u=20:-4:2
u = [1x5 double]
20. 16. 12. 8. 4.

For

The easiest loop structure for a fixed number of iterations is written with for ... end.

u1=4

Example: Calculation of 20 terms of a sequence defined by recurrence by: {u —w 4+2n43
n+1 — “n

Algorithm Scilab Editor
Put 4 in u(1) u(l)=4;
For n from 1 to 20 for n=1:20
u(n+1) takes the value u(n)+2n+3 u(n+l)= u(n)+2*n+3;
Display n and u(n) disp([n,u(n)])
End for end
While

To stop a loop when a given goal is reached, while ... endis used.

| planted a Christmas tree in 2025 measuring 1.20 m. It grows by 30 cm per year. | decided to cut
it when it exceeds 7 m. In what year will | cut the tree?

Algorithm Scilab Editor
Put 1.2 in h (h = tree height) h=1.2;
Put 2025 invy (y = year) y=2025;
While h<7 while h<7
h takes the value h+0.3 (the tree grows) h=h+0.3;
y takes the value y+1 (one year passes) y=y+1;
End while end
Display y (the final year) disp("I will cut the tree in "..

+string (y))

Mention

When a command is too long to be written in one line, the editor will wrap lines. One can also wrap lines using “ . . “ (two
dots) before going to the next line.
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Tests

Comparison operators

Useful tests include comparing numbers or determining whether a statement is true or false.
Below the corresponding commands:

. Greater or
Equal Different Less Greater Less or equal
equal
== <> < > <= =>
True False And Or No
$T SF & | ~
Mention
Be cautious with calculation accuracy. Calculations are approached and “ == “ will sometimes give wrong results (see

Calculation accuracy, page 28).

To compare two vectors (or two matrices), the tests “==“and “ <> “ will compare term by term.
For example:

-->X=[1,2,5]; Y=[5,3,5];

—->X==Y
ans =[1x3 boolean]
FFT

To test if two vectors are equal, isequal is used and ~isequal is used if they are different:
-->isequal (X,Y)
ans =

F

-->~isequal (X,Y)
ans =

T

If...then

The basic conditional statements are the following:

e if ... then ... else ... end,
e if .. then .. elseif ... then ... else ... end.

if ... then must be written on the same line and likewise with elseif ... then.
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Example: Alice throws three dice.

e If she gets three 6’s she wins $20,

e If she gets three identical numbers different from 6 she wins $10,
e If she gets two identical numbers she wins $5,

e Otherwise she wins nothing.

Simulate a trial and calculate Alice’s winnings using the functions:
e grand (see page 21),
e unique (D keeps only once the values that appears several times in D,
e length (unique (D)) returns the size of the obtained vector, that is to say 1 if three
dice are equal, and 2 if two dice are equal.

Algorithm Scilab Editor
Put the three values in D D=grand (1,3, "uin",1,6);
If Alice gets three 6, then if D==[6,6,6] then
Alice wins 20 dollars W=20;
Else if she receives three identical values, elseif length (unique (D))==1 then
then W=10;

Alice wins 10 dollars elseif length (unique (D))==2 then

Else, if she receives two identical values,

W=5;
then
else
Alice wins 5 dollars
W=0;
Otherwise
end

Alice wins nothing

End if

disp("Alice wins "+..

) . o string(W)+ " dollars")
Display Alice's winnings

2-D and 3-D plots

plot command is used to create plots in the plane. Color and appearance can be specified by
putting indications of color and points style within quotes:

e Colors
"b" = blue (by default), "k" = black, "r" =red, "g" =green, "c" =cyan, "m" = magenta,
"y" =yellow, "w" = white.

e Point styles
Joined (by default), or " . ", "+", "o", "x", "*",

Other options are available with: "s", "d", "v", "<", and ">".
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Basic plots
To plot a point
Plot the point A(1 ; 2) with a red point.

Scilab Editor Graphics Window
B Graphic window number 0 - [=] b
plot(l1,2,".r")
To plot a segment
Plot the segment [AB] in blue (by default) with A(1; 2) and B(3; 5).
Scilab Editor Graphics Window

B Graphoc window number 0

File Tools Edit 7
SRRy E O
Graphic window number

plot([1,3],[2,5])

Plots of plane curves defined by functions y=f(x)

For a function x = f(x) the values of X are specified using the 1inspace command by writing:
x=linspace (a,b,n) ; where ais the smallest value of the variable x, b the highest value of x,
and n the number of values calculated between a and b.

Do not forget the “ ; “ symbol otherwise all n values of x will be displayed.

For example, consider two functions f and g defined over the interval [-2 ; 5] by:

f(x) = (x? + 2x)e™, and g(x) = sin (’z—c)
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With the program below, we plot the curve defined byf, in blue by default:

Scilab Editor

Graphics Window

function y=f (x)

y=(x"2+2*x) *exp (-x)

endfunction
x=linspace (-2,5,50);

plot(x, f)

By adding the program below, we obtain the plot of two curves, that of £ in red and that of gin
green. The previous plot was cleared through the ¢1£ command (“ clear figure “).

Scilab Editor

Graphics Window

function y=g(x)

y=sin (x/2)
endfunction
x=linspace (-2,5,50);
clft

plot(x,£,"r",x,9,"g")

Plots of sequences of points

Terms of a sequence

The most common case is to plot the sequences of points M(n,u(n)) after calculating the
coordinates u(n) of a vector u. plot (u,"*r") specifies the style and color of the points in
quotes: red and non-connected stars. By default, points are plotted in blue and are connected.

Scilab Editor

Graphics Window

for n=1:50
u(n)=(-0.8)"n;
end

clf; plot(u,"*r")
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Bivariate statistical data

Bivariate statistical data are given in the form of two vectors: let’s call them X and Y.
plot(X,Y,"<") will plot a scatter plot of M(X;; Y;) with blue triangles.

Scilab Editor Graphics Window

I Graphic window number 0 - o x
Fie Tools Bt ?
B ROAR| TV D

Graphic winduw nunber O

X=[1,3,3,7,7,9,10];
Y=[8,7,5,5,4,2,2];

clf; plot(X,Y,"<")

Plots in 3 dimensions

Scilab can be used to plot surfaces and curves in space, with many options for the treatment of
hidden faces, face colors, points of view, etc. The following examples will illustrate 3-D plots.

The surf function can be used for plotting surfaces. This function has three input variables, x, y
and z. x and y are respectively vectors of size m and n corresponding to points on the axes (Ox)
and (0y). z is a matrix of dimension n X m with element z;; corresponding to the height of the
point with X-coordinate x; and Y-coordinate ;.

To plot the surface defined by a function of the form z = f(x, y), it is necessary to :

e Define function f

e (Calculate z=feval (x,y,£f) '
feval (x,y, f) returns the m X n matrix whose ij element is f(x;, y;) which will be
transposed by using the single quote symbol “ ' “

e Execute surf(x,y,z).

To plot the surface z = 2x? + y? (elliptic paraboloid):

Scilab Editor Graphics Window
function z=f (x,vVy) ;‘ ook &t 7
B RAR OV ¢ O

z2=2*x"2+y"2;
endfunction
x=linspace(-1,1,100);
y=linspace(-2,2,200);
z=feval (x,y,f)"';

clf

surf(x,y,z)
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Curves in space may be plotted using the param3d function. param3d has three arguments, x,
y and z, each vectors has the same dimension and corresponds to the points (x;,y;,z;) on the
curve.

To plot the helix defined by (x = cos(t),y = sin(t),z = t):

Scilab Editor Graphics Window

1B Gragt
Fie Too
B RAA T D
pr—

dow number 0 - o x

t=linspace (0,4*%pi, 100); ,f T

clf ; param3d(cos(t),sin(t),t)

Simulations and statistics
Several functions are available in Scilab to perform simulations quickly and efficiently.
Random sequences

e grand(l,p,"uin",m,n) returns a vector of p random integer sequences between
m and n with p positive integer, m and n integers and m < n.

-->t= grand(1l,4,"uin",1,6)
t = [1x4 double]

3. 1. 3. 6.

e grand(l,p,"unf",a,b) returns a vector of p random real sequences between a
and b with p positive integer, a and b real and a < b.

-->tr= grand(l,2,"unf",-1,1)
tr = [1x2 double]

- 0.7460264 0.9377355
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Statistics
All the standard statistical functions are listed on page 31.
Keep particularly in mind:

e The functionbar (x,n,color) which draws bar graphs:

Scilab Editor Graphics Window

x=[1:10];
n=[8,6,13,10,6,4,16,7,8,5]1;

clf; bar(x,n)

e For a bar graph representing two sets side by side: consider the series of values X and the
two series of numbers n1 and n2. For plotting, n1 and n2 must be column vectors that is
why transposes are used in the example below:

Scilab Editor Graphics Window

window number 0 - o x

x=[1,2,5];n1=[5,10,5];n2=[6,8,7];

clf; bar (X, [nl',n2'])

The color optional argument defines the color as in the plot function.

Additional information on matrices and vectors
Accessing elements

Square braces are used to define matrices. A space or a comma is used to switch from one column
to another and semicolons are used to switch from one line to another.

-->m=[1 2 3;4 5 6]

- Mention
m = [2x3 double] This command can also be
typed under the form:
1. 2. 3. m=[1,2,3;4,5,6]
4. 5. 6.
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Parentheses are used to access elements or to modify them.

-->m (2, 3)

ans =
6.

-->m(2,3)=23

m = [2x3 double]
1. 2. 3.
4. 5. 23.

The “: “ operator is used to designate all the rows or all columns of a matrix.

To view the second row of the matrix m, type:
-->m(2,:)
ans = [1x3 double]

4. 5. 23.

And the third column:
-=>m(:,3)

ans = [2x1 double]

23.

Iu Vo,

To obtain the transpose of a matrix or a vector use the single quote symbo

-—>m'
ans = [3x2 double]
1. 4.
2. 5.
3 23
Operations

The operations “ * “, “ / “ are matrix operations. To make element wise operations, we need to
put a dot before the operating sign: “ .*“,“ ./ “.

-->A=[1,2,3;4,5,6]
A = [2x3 double]

1. 2. 3.
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4. 5. 6.

-->B=[1;1;2]

B = [3x1 double]

-->A*B
ans = [2x1 double]
9.

21.

Matrix multiplication

-->A*A

Operator *: Wrong dimensions for

Dimensions are not consistent

operation [2x3] * [2x3].
-=>A.*A
ans = [2x3 double]
Element wise multiplication
1. 4. 9.
16. 25. 36.
—=>2* (A+2)
ans = [2x3 double] L
The operation is performed on each element
6. 3. 10. because 2 is a number
12. 14. 16.
Gives the matrix X for which X*A = A
-->A/A The exact result is:
1. 0
ans = [2x2 double] 0 1.
1. 5.061D-17 For reasons of calculation accuracy, the result can
5 702D-1 1 be slightly different depending on your version of
-2.702D-15 . Scilab and your operating system (see calculation
accuracy, page 28).
-->A. /A
ans = [2x3 double]
Gives the matrix divided element wise
1. 1. 1.
1. 1. 1.

In the case of vectors:

-->C=1:4
C = [1x4 double]

1. 2. 3. 4.

-=>C*C

Operator *: Wrong dimensions for

operation [1x4] * [1x4].

Dimensions are not consistent
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-->C.*C

ans = [1x4 double]
1. 4. 9. 16.
-->(1)./C
Reverse element wise
ans = [1x4 double] The parentheses around 1 are necessary so that
the point is not considered as a comma as part of
1. 0.5 0.3333333 the number 1. It is also possible to write1 . /C
0.25 with a space between 1 and “ . “

Solving linear systems
To solve the linear system AX =Y, in which A is a square matrix, use the backslash “\ “
X=A\Y.

Be cautious, the operation Y / A will give (only if the dimensions are correct) another result, that is
to say the matrix Z for whichZA =Y.

To solve the system: (i é 2) XX = (D

-—>A=[1 2 3;4 5 6];

-=>y=[1;1];

—-—>X=A\Y

X = [3x1 double]
- 0.5000000

0.5000000
-=>A*X
ans = [2x1 double]

1.000000

1.
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Some useful functions

Sort

The gsort function is used to sort the elements of a vector in ascending or descending order.

-->v=[2,6,9,6,-4,0,2]
v = [1x7 double]

2. 6. 9.

—_—> gSOrt (V, vvg", vvi")
ans = [1x7 double]

- 4, 0. 2.
--> gsort (v)
ans = [1x7 double]

9. 6. 6.

Length

The 1length function returns the number of coordinates for a vector. The size function returns

the dimensions (rows, columns) for a matrix.

-->U=[1:10]
U = [1x10 double]
1. 2. 3.
-->length (U)
ans =
10.

-->m=[1 2 3;4 5 6];

-->size (U)
ans = [1x2 double]

2. 3.
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Sum and product

The sum and prod functions respectively calculate the sum and the product of their argument

elements.
-->U=[1:101;
—=>sum (U)
ans =
55.
-->prod (U)
ans =
3628800.
Unique

The unique function keeps only once the elements of a vector (even if they are repeated several
times) and sorts them in ascending order.

-->v=[2,6,9,6,-4,0,2]
v = [1x7 double]

2. 6. 9. 6. - 4. 0. 2.

—-->unique (v)
ans = [1x5 double]

- 4. 0. 2. 6. 9.

Find
The £ind function searches for elements in a vector or a matrix and returns a vector containing

the corresponding indices.
To find all the elements of the vector w smaller than 5:
-->w=[1,5,3,8,14,7,3,2,12,6]; find(w<5)
ans = [1x4 double]

1. 3. 7. 8.

The resulting vector (1,3,7,8) indicates that elements w;, w3, w; and wg are smaller than 5.
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To find all the elements of the vector w equal to 3:
-->w=[1,5,3,8,14,7,3,2,12,6]; find(w==3)

ans = [1x2 double]

3. 7.

The resulting vector (3,7) indicates that elements w3 and w, are equal to 3.

Accuracy computation
Computation
Numbers have an absolute value between about 2.2x1073% and 1.8x10*3%,

The number $eps equals to 2.220446049D-16 gives the smallest relative precision that can
be obtained in computations, which therefore gives about 16 decimal digits.

Example 1: Computation of sin(m)
-->sin (%pi)
ans =

1.225D-16

The value of sin(m) above is not 0, but it is considered as zero. Indeed, compared to the maximum
value of the sine function (i.e. 1), it is equal to 0 with a value less than %eps.

Example 2: Testing if the triangle with sides /3, 1 et 2 is a right-angled triangle:

-->a=sqrt (3)
a =

1.7320508

-—>pb=1

b =

1.

-=>c=2

C =

2.

——>a"2+p 2==c"2

The program responds false
because the value of a*2 + b A 2 is approximate

ans =
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-—->abs (a”2+b"2-c"2)<%eps

The program responds false because absolute
precision is called for

ans =

F

-->abs (a"2+b"2-c"2) /c"2<%eps

The program responds true because relative
precision is called for

ans =

T

Display

Results are displayed, by default, with 10 characters, including the decimal point and the sign. The
format function is used to display more digits. To display 20 digits, type format (20).

Reconsidering a = V3:

-=>a”2

Here there are 7 decimal places, and we do not
see the error.

ans =

3.

-->format (20)

Here there are 17 decimal places, and we can see
-=>a’2 the error

ans =

2.99999999999999956

Solving differential equations

To find the solutions of an explicit system of differential equations, simply reduce to differential
equations of order 1.

{y’(t) =f(t,y(®)
y(to) = o
then apply the ode function: y=ode(y0,t0,t,f), with:

in which t, and t represent time and y, and y(t) are vectors,

e yO:initial condition, vector with dimension n,

e  tO0:initial time,

e t:vector with dimension T corresponding to the times in which the solution is computed.
This vector must begin with t0.

e f: function defining the system under the form:

function yprim=f (t,y)
yprim(1l)=...

yprim(2)=...

yprim(n)=...

endfunction
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yi(D) ¥y (2 i oy (1)
T )’2§1) )’2'(2) : yZ(T)

yn&l) yn.(Z) yntT)

The solution y is a matrix of dimension n x

. . . . y' = -4y
Example: Solving the differential equation { ,
. ¢ K y(0) =3,y'(0) =0

This equation of order 2 is reduced to a system of two equations of order 1 as defined by:

Y(1 . Yprim(1) N Yprim(1) = Y(2)
r= (YEZ%) - (;,),anm = (yﬁiﬁﬁ@) - (3}:) and Yz;rrlirrnn(z) = —4xY(1)

Comment Scilab Editor

We define the function returning output vectory’ function yprim=f (t,y)

from input variables t and y (y is a vector). yorim (1) =y (2) ;

yprim(2)=-4*y (1) ;

endfunction

We define the values of t for plotting. £0=0: tmax=5:

(the solver chooses itself the good values of t for
the internal computation of the solution).

t=t0:0.05:tmax;

y0=3; yprim0=0;
We define the initial conditions.

y=ode ([y0;yprim0], t0, t, f);
We execute ode.

clf; plot(t,y(1,:))
We plot the integral curve of y with respect to t.

[ B Graphic window number 0 = O X
| File Tools Edit ?
CCEERR I

Graphic window number 0 2
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Chapter 3 — Useful Scilab functions

Analysis

sgrt (x) returns the square root of x with x real positive or zero, and the complex root
of real positive part otherwise.

log (x) returns the natural logarithm of x with X real or complex number.

exp (x) returns the exponential of x with x real or complex number.

abs (x) returns the absolute value of x real (or the module if x is complex).

int (x) returns the truncation of x real (the integer before the decimal).

floor (x) returns the integer part of x real (the integer n for whichn < x <n + 1).
ceil (x) for x real returns the integer n for whichn —1 < x < n.

Probability and statistics

factorial (n) returns the factorial of n with n positive or zero integer.
grand(l,p,"uin",m,n) returns a vector of p random integer sequences taken
between m and n with p positive integer, m and n integers and m < n.
grand(l,p,"unf" ,a,b) returns a vector of p random integer sequences taken
between a and b with p positive integer, aand b real and a < b.

sum (n) returns the sum of the values of vector n (used to calculate a total).

cumsum (n) returns the vector of increasing cumulative values of vector n (used to
calculate the increasing cumulative numbers).

length (v) returns the number of coordinates of vector v.

gsort (v) returns the vector of numbers or strings v sorted in descending order.
gsort(v,"g","i") returns the vector of numbers or strings v sorted in ascending
order.

mean (v) returns the average of the vector of numbers v.

stdev (v) returns the standard deviation of numbers v vector.

bar (v,n,couleur) draws the bar graph with v as X-coordinate, n as Y-coordinate, v
and n being same size line vectors. By default, bar (n) draws the bar graph of n in blue
with 1,2,3... as X-coordinates.

bar (v, [n1',n2’]) draws a double bar graph with v as X-coordinate, nl as
Y-coordinate in blue and n2 as Y-coordinate in green, with v, n1 and n2 being same size
line vectors.

rand (n,p) with n and p positive integers, returns a matrix n X p of numbers randomly
taken between 0 and 1.

rand () returns a real number randomly taken between 0 and 1.

floor (x) returns the integer part of x real number. In particular, if p is real between 0
and 1, floor (rand () +p) will be 1 with p probability and 0 with 1 — p probability.
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Display and plot

Utilities

clf means “ clear figure “ and clears the current figure on the graphics window.

plot allows to draw curves and scatter plots in 2 dimensions.

linspace(a,b,n), with a and b real and n integer, defines a vector of n values
regularly spaced between a and b.

scf allows to open or to select other graphics windows than the current one.

surf allows 3-D surface plots.

bar (X, Y) in which Xand Y are vectors, draws the bar graph of the series of values for X
which has for numbers the values of Y.

plot(X,Y,"*") draws the scatter plot of coordinates (X(i),Y(i)) as stars. The color can
be specified.

plot (Y, "+") draws the scatter plot of coordinates (i,Y(i)) as cross.

disp ("Sentence") displays what is written in double quotes.

disp (A) in which A is a matrix of numbers, displays the table of the values of A.

disp ("Sentence"+string (x)) displays the sentence and the value of number x.

unique (v) returns the vector v with a unique occurrence of its repeated components
in increasing order.

sum (v) returns the sum of all the elements of the vector or the matrix v.

prod (v) returns the product of all the elements of the vector or the matrix v.

find (<test about wv>) returns the indices of the elements of vector v satisfying
the test.

disp(x,y,...) displays the values of its arguments in the console.

string (x) converts number x to a string.

format (n) in which nis an integer greater than or equal to 2, sets the display to n
characters, including the sign and the decimal dot.

zeros (n,p) defines a n X p matrix that only contains zeros.

feval (x,y, £) in which x and y are respectively vectors of size m and n, defines the
matrix m X n whose element (i, j) is f(x (i), y(j)).

help function opens the help browser on the right function page.

tic starts a timer.

toc stops the timer.
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